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Paper Set 1 · 19 Jun 2026 · 4:00 PM - 5:30 PM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
P, Q and R started a business in partnership. Initially, P invested
₹2,900 while Q and R invested ₹2,500 each. After 4 months, P
withdrew ₹300. After 2 more months, R invested ₹1,200 more. Find
the share of R (in ₹) in the profit of ₹3,320 at the end of the year.

A.  ₹1,220

B.  ₹1,240

C.  ₹1,250

D.  ₹1,260

✓

Q2 Quant
A carriage running in a fog crossed a man who was walking at the
rate of 5 km/hr in the same direction. He could see the carriage for
half a minute, and it was visible to him up to a distance of 50 m.
What was the speed (in km/hr) of the carriage?

A.  9

B.  8

C.  10

D.  11

✓

Q3 Quant
Two trains start simultaneously from two stations 150 km apart and
move towards each other on parallel tracks. If their speeds are 40
km/h and 50 km/h, how long will they take to meet?

A.  1 hour 20 minutes

B.  1 hour 30 minutes

C.  1 hour 40 minutes

D.  1 hour 50 minutes

✓

Q4 Quant
The marks of 8 students in a test are: 45, 50, 55, 60, 65, 70, 75, x. If
the average marks are 60, what is the value of x?

A.  40

B.  60

C.  70

D.  80

✓

Q5 Quant
A trader buys cryptocurrency for ₹10,000. Its value rises by 20%, and
then falls by 10%. What is the final value of the investment?

A.  ₹10,000

B.  ₹10,800

C.  ₹10,900

D.  ₹11,000

✓

Q6 Quant
Arrange the following ratios in ascending order.
9:13, 13:21, 23:29 and 33:44

A.  13:21, 9:13, 33:44 and 23:29

B.  9:13, 13:21, 33:44 and 23:29

C.  9:13, 33:44, 13:21and 23:29

D.  13:21, 9:13, 23:29 and 33:44

✓

Q7 Quant
An amount of ₹60,91,094 is divided among R, S and T in such a
manner that the ratio of the amount of R to that of S is 2 : 5 and the
ratio of the amount of S to that of T is 3 : 8. Find the amount of
money received by T.

A.  ₹5,99,124

B.  ₹14,97,810

C.  ₹39,94,160

D.  ₹45,93,284

✓

Q8 Quant
Find the median of the following data.
Class interval 0-5 5-10 10-15 15-20 20-25 25-30
Frequency 2 4 5 3 4 2

A.  10

B.  12

C.  14

D.  16
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✓

Q9 Quant

Find the least value of (P2 + P) for which the six-digit number 958P71
is divisible by 11.

A.  45

B.  50

C.  56

D.  63

✓

Q10 Quant
Water flows out through a circular pipe whose internal diameter is 2
cm, at the rate of 3 metres per second into a cylindrical tank, the
radius of whose base is 75 cm. By how much will the level of water
rise in 30 minutes?

A.  96 cm

B.  98 cm

C.  105 cm

D.  97 cm

✓

Q11 Quant
If 20% of a number is added to 48, then the result is the same
number. 70% of the same number is:327

A.  42

B.  52

C.  72

D.  62

✓

Q12 Quant

Given that 1160.26 = x, 1160.1= y and xz = y4 , then the value of z is
close to:3028

A.  1.54

B.  0.58

C.  3.39

D.  2.42

✓

Q13 Quant
If, at the same annual rate of interest, the simple interest in 2 years
is ₹60 and the compound interest (compounded annually) for 2
years is ₹66, what is the principal (in ₹)?

A.  150

B.  145

C.  143

D.  154

✓

Q14 Quant
The total surface area of a solid cylinder having radius 9 cm and
height 14 cm is:2690

A.  414π cm2

B.  348π cm2

C.  433π cm2

D.  440π cm2

✓

Q15 Quant
Rahul sells a table to Mohit at a profit of 25%, and then Mohit sells it
to Vinod at a profit of 40%. If Vinod pays ₹6,475 for the table, its cost
price (in ₹) for Rahul is:

A.  3,700

B.  3,701

C.  3,699

D.  3,698

✓

Q16 Quant
One pipe can fill the tank in 4 minutes, while another pipe can
empty a completely filled tank in 8 minutes. If both the pipes are
operated together when the tank is empty, how long (in minutes)
will it take to fill the tank completely?

A.  8

B.  9

C.  10

D.  11

✓

Q17 Quant
The product of (x - 17) and (x + 8) is:

A.  x2 - 9x - 136

B.  x2 + 10x - 136

C.  x2 - 8x + 136

D.  x2 + 9x + 136

✓

Q18 Quant
A number is increased by 15% and then decreased by 10%. What is
the net percentage increase in the number?

A.  25%

B.  5%

C.  2.5%

D.  3.5%
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✓

Q19 Quant
A can complete a piece of work in 12 days and B can complete the same work in 15 days. If both work together, in how much time will the two-
thirds of the work be completed?

A.  

B.  

C.  

D.  

✓

Q20 Quant
The area of a regular hexagon inscribed in a circle of radius 3 cm is:

A.  

B.  

C.  

D.  

GA

✓

Q21 GA
Which of the following cities of Odisha has the Biju Patnaik
International Airport?

A.  Bhubaneswar

B.  Cuttack

C.  Rourkela

D.  Sambalpur

✓

Q22 GA
In 2025, Operation Muskaan-XI, a special month-long drive launched
by the Cyberabad Police to trace missing children and rescue minors
from exploitation, was conducted in which Indian State?

A.  Telangana

B.  Maharashtra

C.  Rajasthan

D.  Madhya Pradesh

✓

Q23 GA
The Union Cabinet approved the Capital Region Ring Road
(Bhubaneswar Bypass) with what sanctioned length?

A.  98.400 km

B.  110.875 km

C.  125.000 km

D.  150.250 km

✓

Q24 GA
The sudden downward movement of rocks triggered by earthquakes
or heavy rainfall is called:

A.  Soil creep

B.  Deposition

C.  Erosion

D.  Landslide
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✓

Q25 GA

According to reports published in 2025, a shift from confrontation to
dialogue was observed in the long-running Mahanadi water dispute
between Odisha and which neighbouring state?

A.  West Bengal

B.  Chhattisgarh

C.  Andhra Pradesh

D.  Jharkhand

✓

Q26 GA
Where did Uttar Pradesh Chief Minister Yogi Adityanath inaugurate
India’s second and the state’s first green hydrogen plant in August
2025?

A.  Varanasi

B.  Lucknow

C.  Gorakhpur

D.  Kanpur

✓

Q27 GA
Which of the following Acts replaced the old direct tax law of 1961
with a modernised tax framework in 2025?

A.  Income‑tax Act, 2025

B.  Taxation Laws (Amendment) Act, 2025

C.  Finance Act, 2025

D.  Direct Tax Simplification Act, 2025

✓

Q28 GA
Which country hosted the 2025 ITTF World Table Tennis
Championships Finals?

A.  Qatar

B.  Australia

C.  France

D.  Brazil

✓

Q29 GA
Which play written by the poet Kalidas tells the story of King
Dushyanta and Shakuntala?

A.  Meghaduta

B.  Raghuvamsha

C.  Abhijnana Shakuntalam

D.  Ritusambara

✓

Q30 GA
Which of the following pairs is correctly matched with their
associated classical dance form?

A.  Rukmini Devi Arundale - Odissi

B.  Birju Maharaj - Kathak

C.  Kelucharan Mohapatra - Manipuri

D.  Yamini Krishnamurthy - Mohiniattam

✓

Q31 GA
In the context of economic problems in India, particularly limited
access to institutional credit in rural and priority sectors, which
measure did the government introduce in 1969 to improve access to
institutional credit in these sectors?

A.  The devaluation of the Indian rupee

B.  The nationalization of 14 major banks

C.  The introduction of the New Industrial Policy

D.  The establishment of the Planning Commission

✓

Q32 GA
The Election Commission of India is mentioned in which Part of the
Constitution of India?

A.  Part XV

B.  Part III

C.  Part V

D.  Part IX

✓

Q33 GA
The northern boundary of the Peninsular Block extends from
Kachchh to which of the following regions?

A.  Eastern Ghats

B.  Rajmahal Hills

C.  Satpura Range

D.  Nilgiri Hills

✓

Q34 GA
Between which two rivers do the Himalayan mountain ranges
stretch in a west-east direction?

A.  Indus and Ganga

B.  Narmada and Godavari

C.  Indus and Brahmaputra

D.  Jhelum and Tista
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✓

Q35 GA
Which of the following carbon compounds is most likely to burn
with a yellow smoky flame?

A.  Ethanol

B.  Acetone

C.  Methane

D.  Benzene

✓

Q36 GA
Which practice can help reduce nonbiodegradable waste?

A.  Encouraging more packaging

B.  Increasing disposable items

C.  Using reusable packaging

D.  Promoting single-use plastics

✓

Q37 GA
Which of the following renewable energy sources depends most
directly on flowing or falling water to generate electricity?

A.  Biomass energy

B.  Hydropower

C.  Solar thermal energy

D.  Geothermal energy

✓

Q38 GA
Which statement correctly distinguishes between mass and weight
in terms of their physical nature?

A.  Mass is a force, weight is not

B.  Weight is a force, mass is not

C.  Both are forces

D.  Both are directionless quantities

✓

Q39 GA
Which aspect of the "Panchasakha" tradition significantly influenced
the spread of devotional literature in Odisha?

A.  Exclusive use of Sanskrit and Hindi for religious compositions

B.  Usage of the Odia language to make spiritual ideas
accessible to the masses

C.  Focus on complete abolition of religious practices

D.  Exclusive promotion of temple architecture for literary
activity

✓

Q40 GA
In which of the following years, the Press and Registration of Books
Act was enacted with a view to evaluating the position of books,
newspapers, and magazines in the country at any given time?

A.  1867

B.  1873

C.  1879

D.  1885
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English

✓

Q41 English
Select the option that can be used as a one-word substitute for the given group of words.

A handwriting that cannot be read

A.  Eligible

B.  Legible

C.  Illegible

D.  Elegible

✓

Q42 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

(P) disability and normality is blurred, discussing
(Q) disability as an individual identity
(R) and as a social category
(S) they argue that the line between

A.  PRQS

B.  SPQR

C.  SPRQ

D.  QPRS​​​​

✓

Q43 English
Choose the correct idiom to replace the underlined part of the following sentence.
After his long journey, he felt completely drained and decided to go to bed immediately.

A.  hit the hay

B.  sleep on it

C.  turn over a new leaf

D.  lose sleep over it

✓

Q44 English
Select the correct Passive form of the following sentence.
The workers will complete the project next week.

A.  The project will be completed by the workers next week.

B.  The project will completed by the workers next week.

C.  The project is completed by the workers next week.

D.  The project will have been completed by the workers next week.

✓

Q45 English
Choose the sentence that uses the correct form of the present tense from the options given below.

A.  She is knowing the answer but refuses to say it.

B.  They has been working on the project since morning.

C.  He plays the guitar beautifully and often performs on weekends.

D.  I am agree with your suggestion completely.
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✓

Q46 English
Choose the correct meaning of the underlined proverb.
If you are a manager of a top football club and you can't stand the heat, you should get out of the kitchen.

A.  If you face problems, ignore them calmly.

B.  If you avoid stress, you’ll perform better.

C.  If you work hard, success comes easily.

D.  If you can’t handle pressure, leave the job.

✓

Q47 English
Select the most appropriate antonym of the underlined word in the given sentence.
The witness gave a genuine statement that matched the facts.

A.  Fake

B.  Honest

C.  Real

D.  Clumsy

✓

Q48 English
From the options given below, choose the sentence which is correctly written in indirect speech.

A.  She said that she was cooking dinner when I arrived.

B.  She said that she cooked dinner when I arrived.

C.  She said that she have cooked dinner when I arrived.

D.  She said that she had been cooking dinner when I arrives.

✓

Q49 English
Select the most appropriate ANTONYM of the highlighted word.

The scientist's hypothesis was conventional for its time.

A.  normal

B.  traditional

C.  abysmal

D.  unorthodox
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✓

Q50 English

Read the passage and answer the questions that follow.

Artificial Intelligence (AI) has rapidly transformed various aspects of modern life, from healthcare and education to transportation and
communication. While AI offers efficiency, accuracy, and convenience, it also raises significant ethical concerns. One major issue is the potential
loss of jobs as machines increasingly replace human labour. This shift creates uncertainty about economic stability and the future workforce.
Another concern involves decision-making by AI systems. Algorithms may unintentionally reflect biases present in the data they are trained on,
leading to unfair or discriminatory outcomes. Questions also arise regarding accountability—when an AI system makes an error, it becomes
difficult to determine who is responsible. Furthermore, the use of AI in surveillance and data collection has sparked debates about privacy and
individual freedom. Despite these challenges, AI continues to advance, offering immense possibilities. Therefore, it is essential to establish
ethical guidelines and regulations to ensure that AI development remains beneficial, fair, and aligned with human values.

Identify a suitable title for the passage.

A.  The Growth and Applications of Artificial Intelligence Systems

B.  The Ethical Challenges with Artificial Intelligence Development

C.  The Role of Technology in Improving Daily Human Activities

D.  The Impact of Automation on Industrial Productivity Levels

✓

Q51 English
Which of the following statements is correct, according to the passage?

A.  AI systems can reflect biases present in their training data

B.  AI completely eliminates all forms of human decision-making

C.  AI has no influence on employment opportunities worldwide

D.  AI development does not involve any ethical considerations

✓

Q52 English
Identify the tone of the passage.

A.  Celebratory and enthusiastic about technological achievements

B.  Casual and conversational about everyday digital usage

C.  Satirical and mocking about artificial intelligence systems

D.  Analytical and cautious about emerging technological issues

✓

Q53 English
Identify the structure of the passage.

A.  Chronological history of artificial intelligence development

B.  Dialogue presenting contrasting opinions on technology

C.  Introduction of concept followed by issues and concluding suggestion

D.  Narrative story describing fictional technological events

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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✓

Q54 English
Select the correct summary for the passage.

A.  Artificial intelligence only provides benefits without any risks

B.  Artificial intelligence raises ethical issues requiring regulation

C.  Artificial intelligence is mainly used in limited industries

D.  Artificial intelligence replaces all human roles completely

✓

Q55 English
Select the most appropriate article to fill in the blank. If no article is needed, select 'No article required'.

He adopted _________ puppy from the shelter last week.

A.  a

B.  an

C.  the

D.  no article required

✓

Q56 English
Select the option that rectifies the incorrectly spelt word in the given sentence.

The scientist received international recoginition for her breakthrough research.

A.  recognition

B.  recogniition

C.  recoginetion

D.  recognitionn

✓

Q57 English
Sentences of a paragraph are given below in jumbled order. Arrange the sentences in the correct order to form a meaningful and coherent
paragraph.

A. It is mandatory for them to attend an eight-week rigorous training for their deed.
B. This town is situated on the southern coast of the island nation.
C. The plan proposes to educate the motorists who have been accused and convicted of drunken driving.
D. An initiative was launched recently in Southampton in England.

A.  ADCB

B.  ACBD

C.  DBCA

D.  ABDC
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✓

Q58 English
Select the option that can be used as a one-word substitute for the underlined group of words.

For those who take part in such activities for enjoyment rather than as a profession, there will be games and skill tests ranging from a 40-yard
dash to field goal kicks.

A.  adventurers

B.  amateurs

C.  explorers

D.  partisans

✓

Q59 English
Select the most appropriate option to fill in the blank.

My friend Mona is the ________ student of the class.

A.  young

B.  youngest

C.  most young

D.  younger

✓

Q60 English
Fill in the blank with the correct option.

He has a _______ appetite, which worries his parents.3669

A.  voracious

B.  healthy

C.  dreamy

D.  difficult
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Odia

✓

Q61 Odia
ନି ମ୍ନ ରେ ଦି ଆଯାଇଥି ବା ବି କଳ୍ପ ମଧ୍ୟରୁ  ଉପଯୁ କ୍ତ ସମାନାର୍ଥ କ ଶବ୍ଦ ଚୟନ କରନ୍ତୁ ।
କଇଁ

A.  ପୁ ଷ୍ପ

B.  କୁ ମୁ ଦି ନୀ

C.  ପଦ୍ମ

D.  ଅର୍ଚ୍ଚ ନା

✓

Q62 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

ତୁ ମେ ଆମ ଘରକୁ  ନଆସି ଲେ ମୁଁ  ତୁ ମ ଘରକୁ  ଯି ବି  ନାହିଁ ।

A.  I won't go to your house unless you come.

B.  I won't go to your house unless you come to our house.

C.  Iam not going to your house if you are not coming to our house.

D.  I won't go unless you come to our house.

✓

Q63 Odia
ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟକୁ  ଇଂରାଜୀରେ ଅନୁ ବାଦ କର।

କାଲି  ମୋ ଅଜା ଆଈ ଆମ ଘରକୁ  ଆସି ବେ ।

A.  My grandparents are coming to our house tomorrow

B.  My grandparents will come to our house tomorrow.

C.  My grandparents have come to our house .

D.  My grandparents came to our house tomorrow.

✓

Q64 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦକୁ  ପାଠ କରି  ପ୍ର ଶ୍ନ ଗୁ ଡି କର ଉତ୍ତର ବାଛ ।
ମଣି ଷ ଜାତି  ଅତି  ସୁ ବି ଧାବାଦୀ । ସୁ ଖ ସୁ ବି ଧା ପାଉଥି ବା ପର୍ଯ୍ୟ ନ୍ତ ସେ ଭଗବାନଙ୍କର ଜୟଗାନ କରି ଥାଏ । କି ନ୍ତୁ ବି ପଦରେ ପଡି ଲେ ବା ଦୁଃ ଖ ଭୋଗି ଲେ ଜୟଗାନ କରି ବା ତ ଦୂ ରର କଥା; ଅଧି କନ୍ତୁ
ଭଗବତ୍  ନାମସ୍ମରଣ କରି ବାକୁ  ମଧ୍ୟ କୁ ଣ୍ଠାବୋଧ କରି ଥାଏ । ପ୍ର କୃ ତପକ୍ଷେ ତା'ର ଜାଣି ବା ଉଚି ତ ଯେ ଈଶ୍ଵରଙ୍କ ଦରବାରରେ ପାତର ଅନ୍ତର ନୀତି  ନାହିଁ । ଉଦାହରଣ ସ୍ୱରୂ ପ : ଗୋଟି ଏ ଗ୍ରା ମରେ
ଗୋବି ନ୍ଦ ଓ ଗୋପାଳ ନାମରେ ଦୁ ଇଜଣ ସାଙ୍ଗ ଥି ଲେ । ଥରେ ଦୁ ହେଁ  ଜଙ୍ଗଲକୁ  ଜାମୁ କୋଳି  ତୋଳି ବାକୁ  ଯାଇଥି ଲେ । ଗୋବି ନ୍ଦ ଗଛ ଚଢି  ହଲାଇଲା ଓ ଗୋପାଳ ତଳେ ରହି  କୋଳି  ଗୋଟାଇଲା ।
ହଠାତ ଗୋଟେ ଭାଲୁ  ଆସି ବାରୁ , ଗୋପାଳ ଦୌଡି ଲା ଘରଆଡକୁ  ଅଣନି ଶ୍ଵାସୀ ହୋଇ । ଗଛ ଉପରୁ  ଗୋବି ନ୍ଦ ଡାକ ଛାଡି ଲେ ମଧ୍ୟ ସେ ଶୁ ଣି ଲାନାହିଁ । ତାପରେ ଭାଲୁ  ଜାମୁ  ଗଛକୁ  ଚଢି ବାରୁ
ଗୋବି ନ୍ଦ ଗଛରୁ  ଡେଇଁ  ପଡି  ଆହତ ହେଲା ଏବଂ ମନେ ମନେ ଗୋପାଳକୁ  ବହୁ ତ ଗାଳି ଦେଲା । ତାପରେ ଦଳେ ଯୁ ବକ ତାକୁ  ଧରି ନେଲେ ଦେବୀଙ୍କ ପାଖରେ ବଳି  ଦେବା ପାଇଁ  । ବଳି  ଦେବା
ଉଦ୍ଦେଶ୍ୟରେ ପୂ ଜକ ଗୋବି ନ୍ଦକୁ  ତନଖି  କରି ବାବେଳେ ତା' ଖଣ୍ଡି ଆ ଶରୀର ଦେଖି  ସି ଏ ବଳି  ପାଇଁ  ଯୋଗ୍ୟ ନୁ ହେଁ  ବୋଲି  ତାକୁ  ସେଠାରୁ  ଛାଡି ଦେଲେ । ସେତେବେଳେ ତା'ର ଚେତା ପଶି ଲା । ଆଉ
କହି ଲା ଇଶ୍ଵର କେତେ ଦୟାବନ୍ତ ସତେ ।

"ଇଶ୍ଵରଙ୍କର ବି ଚାର ସମସ୍ତଙ୍କ ପାଇଁ  ସମାନ"-ଏହି  କଥାକୁ  ସ୍ପଷ୍ଟ କରି ବା ପାଇଁ  କେଉଁ  ଉଦାହରଣ ଦି ଆଯାଇଛି  ?

A.  ଗୋପାଳ ଘରକୁ  ଦୌଡି ଗଲା ।

B.  ଗୋବି ନ୍ଦ ବଳି  ହେବାରୁ  ରକ୍ଷା ପାଇଲା ।

C.  ଗୋପାଳ ଗଛ ଚଢି ଲା ।

D.  ଗୋପାଳ ଜଙ୍ଗଲକୁ  ଗଲା ।

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q65 Odia

"ଇଶ୍ଵର ଯାହା କରନ୍ତି  ତାହା ପ୍ରା ଣୀର ମଙ୍ଗଳପାଇଁ "- ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  ଏହାର ଉଦାହରଣ କେଉଁ ଟି  ହେବ ?

A.  ଗୋବି ନ୍ଦ ଗଛରୁ  ପଡ଼ି  ଆହତ ହେଲା ।

B.  ଭାଲୁ  ଗଛକୁ  ଚଢି ଲା ।

C.  ଗୋପାଳ ଭୟରେ ପଳାଇଗଲା ।

D.  ଦୁ ହେଁ  ଜଙ୍ଗଲକୁ  ଗଲେ ।

✓

Q66 Odia
ଗୋବି ନ୍ଦ ଆହତ ହେବା ପରେ କେଉଁ  ଘଟଣା ତାଙ୍କ ପାଇଁ  ଉପକାରୀ ହେଲା ?

A.  ସେ ଜାମୁ କୋଳି  ଖାଇଲା ।

B.  ସେ ବଳି  ପାଇଁ  ଅଯୋଗ୍ୟ ହେଲା ।

C.  ସେ ଭାଲୁ କୁ  ଦେଖି ଲା ।

D.  ସେ ଗୋପାଳକୁ   ଡାକି ଲା ।

✓

Q67 Odia
ଗୋବି ନ୍ଦର ଘଟଣା ଦ୍ଵାରା କେଉଁ  ନୀତି  ଉଦାହରଣ ସହି ତ ପ୍ର ମାଣି ତ ହେଉଛି  ?

A.  ସାଙ୍ଗକୁ  ଭରସା କରି ବା ଉଚି ତ ।

B.  ଜଙ୍ଗଲକୁ  ଯି ବା ଭଲ ନୁ ହେଁ  ।

C.  ଇଶ୍ଵର ଯାହା କରନ୍ତି  ଭଲ ପାଇଁ  କରନ୍ତି  ।

D.  ଭୟ କରି ବା ଉଚି ତ ନୁ ହେଁ  ।

✓

Q68 Odia
ନି ମ୍ନ ଲି ଖି ତ କେଉଁ ଟି  ଉଦାହରଣ ଭାବେ ପରି ଚ୍ଛେଦରେ ବ୍ୟବହୃ ତ ?

A.  ମଣି ଷ ସୁ ବି ଧାବାଦୀ ।

B.  ଭଗବାନଙ୍କୁ  ମନେ ପକାଇବା ଉଚି ତ ।

C.  ଗୋବି ନ୍ଦ ଓ ଗୋପାଳଙ୍କ କାହାଣୀ ।

D.  ଦୁଃ ଖ ଭୋଗ କରି ବା ।

✓

Q69 Odia
ପି ଠି ରେ ପଡ଼ି ବା । ଏହି  ଋଢି ର ଅର୍ଥ  କ'ଣ ?

A.  ସାହାଯ୍ୟ କରି ବା

B.  ଦୂ ରେଇ ଯି ବା

C.  ଝଗଡ଼ା କରି ବା

D.  ଅପମାନ କରି ବା

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q70 Odia
ବି ରାଡ଼ି  କପାଳକୁ  ଶି କା ଛାଡ଼ି ବା ' ଏହି  ଋଢି ର ଅର୍ଥ  କ'ଣ ?

A.  ହାରି ଯି ବା

B.  ଅଧି କ ଦୁଃ ଖ ପାଇବା

C.  ଇଚ୍ଛାମତେ ସୁ ଯୋଗ ମି ଳି ବା

D.  ଅପମାନି ତ ହେବା

✓

Q71 Odia
"ଯେପରି  କର୍ମ  କରି ବ ସେପରି  ଫଳ ପାଇବ" - ଏଠାରେ 'ଯେପରି -ସେପରି ' କେଉଁ  ଶ୍ରେ ଣୀର ଅବ୍ୟୟ?

A.  ସମୁ ଚ୍ଚୟୀ ଅବ୍ୟୟ

B.  ପରି ମାଣ ସୂ ଚକ

C.  ସାଦୃ ଶ୍ୟ ବୋଧକ

D.  ନି ତ୍ୟ ସମ୍ବନ୍ଧୀ ଅବ୍ୟୟ

✓

Q72 Odia
ବାହାଘରର ହୋମନି ଆଁ  ହୁ ତୁ ହୁ ତୁ  ହୋଇ ଜଳୁ ଛି ।ଏହି  ବାକ୍ୟରେ ଥି ବା କ୍ରି  ୟାବି ଶେଷଣ ପଦଟି କୁ  ଚି ହ୍ନଟ କର।

A.  ବାହାଘର

B.  ହୁ ତୁ ହୁ ତୁ

C.  ହୋମନି ଆଁ

D.  ଜଳୁ ଛି

✓

Q73 Odia
"ସେ ଅଳ୍ପ ହସି ଲା" ଏଠାରେ 'ଅଳ୍ପ' କେଉଁ  ପ୍ର କାରର କ୍ରି  ୟା ବି ଶେଷଣ?

A.  କାଳବାଚକ

B.  ସ୍ଥାନବାଚକ

C.  ପରି ମାଣବାଚକ

D.  ପ୍ର ଶ୍ନ ବାଚକ

✓

Q74 Odia
'ଅମର୍ତ୍ତ୍ୟ ' ଶଦ୍ଦର ବି ପରୀତ କେଉଁ ଟି  ?

A.  ଅଜର

B.  ଅମର

C.  ମର୍ତ୍ତ୍ୟ

D.  ଦେବ

✓

Q75 Odia
"ଆଜି  ବହୁ ତ ଜୋରରେ ବର୍ଷା  ହେଉଛି  ।" ଏହାକୁ  ଇଂରାଜୀରେ କ’ଣ କୁ ହାଯି ବ?

A.  It rained heavily today.

B.  It is raining very heavily today.

C.  It has been raining today.

D.  It will rain heavily today.
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Computer

✓

Q76 Computer
Where can you find recently opened presentations in MS-
PowerPoint?

A.  Under the File menu in the Recent section

B.  In the Insert tab

C.  On the desktop

D.  In the View tab

✓

Q77 Computer
If you want to insert multiple new rows above row 5 in an Excel
worksheet without overwriting existing data, which of the following
steps is correct?

A.  Select row 5, press Ctrl + Shift + + after selecting multiple
rows

B.  Select row 5, press Delete.

C.  Select row 5, press Ctrl + C.

D.  Right-click row 5 and select Clear Contents.

✓

Q78 Computer
What does it typically mean in an email system when a message
stays in the Outbox rather than going to Sent Items?

A.  The message was deleted by the recipient

B.  The recipient’s inbox is full

C.  The message has not yet been successfully sent

D.  The message was recalled by the sender

✓

Q79 Computer
Which keyboard shortcut is commonly used to open the File menu in
most Windows applications?

A.  Alt + F

B.  Alt + Tab

C.  Alt + Del

D.  Alt + Ins

✓

Q80 Computer
What is the alternative way to edit a cell in MS Excel apart from the
double-click option?

A.  Merge

B.  Press F2

C.  Find

D.  Replace

✓

Q81 Computer
What is the primary purpose of a LAN?

A.  To connect devices over the internet.

B.  To share resources and data between devices.

C.  To provide wireless connectivity.

D.  To block unauthorized access.

✓

Q82 Computer
A Windows user double‑clicks “setup.exe” and an installation wizard
appears. Which broad type of file does “setup.exe” represent?

A.  Text file

B.  Graphics file

C.  Archive file

D.  Executable file

✓

Q83 Computer
Character formatting includes all, EXCEPT:

A.  Font type and size

B.  Bold, italic, underline

C.  Text color and highlighting

D.  Page margins

✓

Q84 Computer
Where is the table creation option in MS Word?

A.  Home tab

B.  Insert tab

C.  View tab

D.  Review tab

✓

Q85 Computer
What does the keyboard's PCB stand for?

A.  Process Control Block

B.  Physical Circuit Board

C.  Printed Control Board

D.  Printed Circuit Board
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✓

Q86 Computer
How do you resize a Clip Art image after inserting it into
PowerPoint?

A.  Click on the image and drag the corner handles to resize

B.  Right-click the image and select Resize Image

C.  Use the Format tab to change the size

D.  Resize options are not available for Clip Art

✓

Q87 Computer
What is a WAN and what is its functionality?

A.  Wide Area Network: A computer network that covers an
extensive geographical area.

B.  Wide Access Network: It provides internet service within a
city.

C.  Wide Area Network: A television channel network that covers
the entire city.

D.  Wide Access Network: A television channel network that
covers the entire city.

✓

Q88 Computer
Which tab in the MS Word menu bar includes options like Margins,
Orientation and Size for page setup?

A.  File

B.  View

C.  Layout

D.  Insert

✓

Q89 Computer
In MS-Excel, to remove blank rows from a table, you need to select
the blank rows in the table. What is the next step after this?

A.  Press CTRL+- (hyphen)

B.  Press CTRL+ delete

C.  Press delete

D.  Press Alt + delete

✓

Q90 Computer
Which of the following commands is used to save and close the
presentation in PowerPoint?

A.  Ctrl+S

B.  Ctrl+Q

C.  Ctrl+W

D.  Ctrl+Z
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Reasoning

✓

Q91 Reasoning
L and M are brothers. O is the mother of the father of both N and K.
N is the brother of M, while K is the sister of L. Q is the mother of L,
while R is the father of N. How is Q related to O?2504

A.  Daughter

B.  Brother's daughter

C.  Son's wife

D.  Son's daughter

✓

Q92 Reasoning

Seven boxes A, B, T, L, E, F and G are kept
one over the other but not necessarily in the
same order. Only five boxes are kept above
F. G is kept second from the top. E is kept
immediately below B but above T. A is not
kept above T. Which box is kept fifth from
the bottom?

A.  L

B.  A

C.  B

D.  T

✓

Q93 Reasoning
Select the pair which follows the same pattern as that followed by
the two set of pairs given below. Both pairs follow the same pattern.
PHE : KKZ
FNU : AQP

A.  PIM : KKH

B.  VTK : QWF

C.  HLA : CPV

D.  SYG : OYC

✓

Q94 Reasoning
If + means −, − means ×, × means ÷ and ÷ means +, then what will
come in place of the question mark (?) in the following equation?

18 − 6 ÷ 34 + 42 × 2 = ?

A.  121

B.  136

C.  148

D.  155

✓

Q95 Reasoning
Which of the following letter-number clusters will replace the
question mark (?) in the given series to make it logically complete?

LOT 2 OQS -4 RSR 8 ? XWP 32

A.  UUQ -16

B.  NHY -32

C.  FGT -33

D.  HYJ -23

✓

Q96 Reasoning
In a certain code language, ‘oven menu fire’ is coded as 'kq jk vg' and
‘fire net charm’ is coded as ‘xd kq mv’. How is ‘fire’ coded in the given
language?

A.  kq

B.  jk

C.  vg

D.  xd

✓

Q97 Reasoning
Six people, E, F, G, P, Q and R, are sitting around a circular table
facing the centre. Only three people sit between E and P when
counted from the left of P. Only three people sit between Q and E. F
sits to the immediate right of Q. Q is an immediate neighbour of G.
Who sits second to the right of R?

A.  G

B.  P

C.  E

D.  Q

✓

Q98 Reasoning
Read the given statements and conclusions carefully. Assuming that
the information given in the statements is true, even if it appears to
be at variance with commonly known facts, decide which of the
given conclusions logically follow(s) from the statements.

Statements: All wheels are cars. All cars are trucks.
Conclusion (I): Some trucks are cars.
Conclusion (II): All wheels are trucks.

A.  Both conclusions (I) and (II) follow

B.  Neither conclusion (I) nor (II) follows

C.  Only conclusion (II) follows

D.  Only conclusion (I) follows

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q99 Reasoning
Based on the English alphabetical order, three of the following four
are alike in a certain way and thus form a group. Which is the one
that does not belong to that group?
(Note: The odd one out is not based on the number of
consonants/vowels or their position in the letter cluster.)11722

A.  INO

B.  RVX

C.  DHJ

D.  NRT

✓

Q100 Reasoning
Refer to the following letter series and answer the question.

(Left) Q A Z W S X C D E R F V T G B Y H N U J M I K (Right)

How many letters are there in the English alphabetical order
between the letter which is fifth from the right end and third from
the left end of the series? 5519

A.  Three

B.  Five

C.  Four

D.  Six
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